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UCF
Objectives

Introduce MS Excel Visual Basic for Applications (VBA)
Record and runn VBA macros

Introduce the VB Editor (VBE)

Edit a VBA macro

Debug and Run macros in VBE



Visual Basic For Applications

A macro writing language
Event-driven programming language

A version of the Visual Basic programming language,
with tools, functions, and methods customized to
manipulate the “object model” of an application

Standard in MS Office: you already have it !

UCF



UCF
How Excel VBA Works

Record, write, or edit recorded VBA code (macros) to automate a
complex or repetitive Excel task
Macros are saved in your specific Excel workbook or globally

Macros can be associated with events: click, double-click,
keystroke, etc to fire them

You may add Windows objects (buttons, dropdown lists, check boxes,
textboxes, dialogue boxes, menus, etc..) then write VBA code for each

The VB editor (VBE) is a part of Excel to view, edit, and run macros
A VB compiler in MS Office executes your code



Demonstration Task

Goal:

Fill in the shown table using the given dataset (in an Excel sheet)

Have the table filled automatically using a VBA macro

Process:

Study the data and plan steps to prepare the summary for 2002
Record a VBA macro while performing these steps

Edit the macro to use it for the rest of the years

Counts of Female Graduate Students Under 25

2002

2003

2004

2005

2006

UCF
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The VB Tool Bar

= Right-click in the toolbars area in Excel and select the Visual Basic
toolbar from the toolbars list
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— Borders
L 0
' Chart
Contral Toolba:: Florid: lHISUﬂI E-EISIE w x
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— Text To Speech
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Recording a Macro

Click the Record button
This dialog box appears
Give a name to the macro
Give a shortcut, if you want

Specify where Excel saves it:
This Workbook
New Workbook
Personal Macro Workbook

Saved in the STARTUP folder in
your Office application directory

Becomes available whenever you
use Excel

UCF

Record Macro

Macro name:
Summarﬂ
Shortout key: Skore macra in:
iZkrl+ This Workbook W
Descripkion:

Macro recorded 2/6) 2008 by Magdy

| Ik | | Cancel




UCF
Record The Macro

Based on my plan, | will do the following while recording:
Turn on the auto filter in Excel, using the first row of the data
Filter to 2002, graduate, women, under 25 years of age
Copy the filtered records and title row to the table sheet
Add summation formulas for the filtered records

Copy and paste-special (values & transpose) the summation
cells into the table under the 2002 title

Go back to Data sheet and remove the filter
End recording

Open VBE to view the recorded macro (next slide)



The VB Editor (VBE

@ Microsoft Visual Basic - VBA Workshop 02.xls - [Module3 (Code)]

j'lgl I ) ‘I{%l :

Project - YBAProject

% Eile Edt View Insert Format Debug Run Tools _dd sindaw

+ 8 atpvbaen.uls (ATPYBAEN.XLA)
B2 funcres (FUNCRES.XLA)
+ @ Internet_Assistant (HTML.XLA)
- &% ¥BAProject (¥Ba Workshop 02.1ls)
=I5 Microsoft Excel Objects
] Shest1 (Data)
1 sheetZ (sheet1)
k.

+

=I5 Modules

@2 Module2

&% Modules
Project
Window

Properties - Thisworkbook x|

Help squestion forhelp & 2 & X
“'”J'“' AN==P=r
m {General) S j |Summar3.r ﬂ
! Option Explicitc \

Zub Suntoar vl

< Design Mode

Project Window
Properties window
Object model window
Toolbox

'oburnary Macro

' Macro recorded 1/24/2008 by Magdy

!
Sheets("Data') .2elect
Rows("1:1").5elect [

Run macro
Pause running
End running
Add break point

Felection.butoFilter

Selection.lutoFilter Field:=1, Criteriasl:="Fall ZOoOz"
Selection.,butoFilter Field:=3, Criterial:="women"
SJelection,hutoFilter Field:=4, Criterial:="GR"
Selection.iutoFilter Field:=5, Criterial:="Under 25"

Fows("1:16").3elect
SFelection.Copy

Sheets ("Sheetl") .3elect
Range ("L20™) .3elect
AotiveShest.Paste

Range ("F23") .Select

|This\'d'orkhook Wiorkbook,
Alphabetic lCategorized ]

AcceptlabelsInFormulas False
AutolpdateFrequency |0
ChangeHistoryDuration |0
ConflickResalution 1 - xlUserResalution

Dakel1904 False
DisplayDrawingObjects  -4104 - xDisplayShape:
DisplayInkCamments True
EnableautoRecover True

Envelopetisible False

HasRoutingslip False

Highlight“hangesonscre F.

I=addin False

Window

KeepChangeHistary
ListChangesOnMewsheel False
shereakkek deskok

Password

ﬂﬂ_ ThisWorkbook “

InactivelistBorderyisiblTrue Pro pe rties

False
T=aUM(R[-2]C:R[-1]C)"™

;J bpplication. CutCopyMode =

AotiveCell.FormulaR1Cl =

Range ("G23") .Select

beciveCell.FormulaRiCl =

Range ("G23") .Select

SJelection.hutoFill Destination:=Range ("G23:023"),

Range ("GZ3:023") .3elect

Range ("F23:023") .3elect

Selection.Copy

Range ("E3"™) .3elect

Selection.Pastel3pecial Paste:=xlPasteValues,
:=False, Transpose:=Trus

— Rows("19:23") .8elect

bpplication.CutCopyMode = False

N Selection.Delete Shift:=x1Up

Sheets ("Data'") . Seleet

Felection.butoFilter

! getl") . 3elect

"=R[-1] C+R[-2]C"

Operation:=x1None,

w

Code
Window

Type:=x1Filllefault

Step by step run

SkipBlanks

February 07, 2008
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UCF
The VBA Subroutine

Sub SubName()

“ Comments

VBA statements
VBA statements

End Sub

VBA statements deal with the Excel object model

Object model: collection of workbooks, sheets, columns,
rows, ranges, cells, charts, formulas, filters, ...etc.

VBA statement basic uses:
Change the properties of an object
Apply methods to the object

10
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Excel Object Model

= Click % (press F2) to start the Object Browser in VBE

% Microsoft Visual Basic - VBA Workshop 02.xls - [Object Browser] M=
% Fle Edt Yiew Insert Format Debug  Rum Tools  Add-Ins  Window  Help Type a question for help = 2 @ X

HEI =R R REERENE SN | p JJJ%H&;,L@ E,\, E
Project - YBEAProject ﬂExcel vl ) | | | | ﬂ
+ Internet_Assistant ~ | j M

- B VBAProject (VBA Wa SCEEIE Restlis
=125 Microsoft Excel Obj Library | Class | Mernber

@ ThisWorkbook, —

= @Edtﬂes Classes Members of 'Range’ Functions /
Madil=1

B FublishObject A |22 Activate Methods ~
Bl PublishOhjects =% AddComment —
B cuenTahle EH Addindent
[Module2 Module 2 QuenTables ER Address

Alphabetic | categorized | B Range | AddressLocal

—— 2 RecentFile =& AdvancedFilter .

Emz] Madul=z @) RecentFiles e AllowEdit Properties
21 RoutingSlip EH Application
2l RTD =@ Anplviames
Bl Scenario =@ AnplyOutlineStyles
Bl Scenarios w | [ER Areas v
Class Range o e . ~

I — Definition of selected item 3
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Running the Macro

= Click the Run button in the VBA menu bar (Or press Alt + F8)
= From the Macro dialogue box choose a macro to run then click Run

Macro @

Macro name:

Step by step
running in VBE
(debugging)

Start VBE
macros
[ Delete | shortcut
Macras in: |.ﬁ.II Cpen Waorkbooks " |

[Descripkion
Macro recorded 162005 by Magdy

= You may run the macro using the short cut

February 07, 2008 FAIR 2008: Introduction to VBA Macros in MS Excel 12



UCF
Running the Macro in VBE

Start VBE from the VBA toolbar (Or press Alt + F11)

Select the macro module in the Project Window (make sure to click
Inside the macro you want to run)

In VBE you may run, edit or debug the macro:
Running the macro:
Use the icons.> “ 4 in VBE toolbar or the Run menu

Keyboard: F5 to run the current macro and Ctrl + Break to
pause the run

Editing the macro
Debugging the macro

Use the Step Into icon = for step by step running
Keyboard: press F8 repeatedly

13



tep by Step Execution and Editin

Change the following to run the macro for the 2003 year

UCF

Sub Surmaryi)

' Surnary Macro
! Macro recorded 1/24/2008 by Magdy Change

Sheet=s|"Data") .3elect tO 2003
Bows("1:1") .3elect

SJelection.lutoFilter

Selection.AutoFilter Field:=1, Criterial:="Fall Z002"

Selection.AutoFilter Field:=3, Criterial:="women™

Selection.AutoFilcer Field:=4, Criterial:="GR"

Selection.AutoFilcer Field:=5, Criterial:="Under Z5"

Rows ("1:16") .Select Replace with: Application.Range(" A1").CurrentRegion.Select
Selection.Copy

Sheets("Sheetl™) .Select

Range ("AZ0") .Select

Letivelhest . Paste

Range ("Fz3") .53elect

Application.CutCopyMode = False Change
AotiveCell.FormulaR1cl = "=3UM(R[-2]C:R[-1]C) "™ tO C:E
Range ("323") .3elect

AotiveCell.FormulaR1Cl = "=R[-1]C+R[-2]C"™

RBange ("G23") .3elect

Selection.lutoFill Destination:=Range ("~77 - 1y Type:=xlFilllefault

Bange ("GZ23:023") .Select

Bange ("FZl:023") .delecr

SGelection.Capsy
Bange ("E3™") .2elect
Felection.Pasteldpecial Paste:=xlPasteValues, Operation:=xlNone, 3kipElanks _
:=False, Transpose:=True
Rows ("19:23") .Select
Ipplication.CutCopyMode = False
Selection.Delete Shift:=x1Up
Sheets | "Data') .Select
SGelection. lutoFilter
Sheet=s("Sheetl") .Select
End Subk

4
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UCF
Error Messages

An example of an error message:

Shows if “Application.” is not used In
Application.Range("Al1").CurrentRegion.Select
Sometimes depending on Excel version

End: Stops execing the macro

Debug: takes you to the error in code | run-tine errar ‘1004
Continue: ignore the error if possible | Set methed of Range dass faied

Common errors:
Misspelling End .Dsbug - Help
Variables not defined
Missing arguments or options
Referencing non-existing sheet or workbook (named object)
Not using Application. before Range, Rows, Columns, Sheets, and few others

15



#"UCF
Some Editing

Referring to a cell: Cel Is(Rowindex,Columnindex)
Cell 1n row 3 and column 21: Cells(3,21).Select

Referring to a cells range: Range(Celll, [Cell2]).Select
Cell 1n row 6 and column 4: Range(“D6’").Select
Range across several rows and columns:

Range(cells(4,6), Cells(12,8)).Select
Range(“‘D4”’,’H12””) .Select

Range of columns: Columns(FirstColIndex, LastCollndex)
Columns 5,6,and 7: Columns(**E”,““G”’) .Select

Range of rows: Columns(FirstRowlndex, LastRowlndex)
Rows 2 through 7: Rows(*“2:7").Select

16



R1C1 Notations in Formulas

R1C1 uses numbers for columns instead of letters

Excel uses this format when recording a macro

Must be inserted as a character in the selected cell range
Ex: Range("C7").FormulaR1C1 = “=SUM(RI[-5]C[1]:R[-2]C[1])*

Microsoft Excel - VBA Workshop 02.xls

Eﬂ File Edit Wiew Insert Format Tools Data 5A5  Window Help  Adobe PFDF
RN REAIE RN A A R A R R e ) | E Y |
-,

§ Calibr -1 -|B I U= B8 % o WB|EEIBE 0 AR S P B ae BEA
F11 - b

A B

D E

NlwlA&| G| O

-2 -1 -1 1 2

=SUM(R[-5]C[1]:R[-2]C[1])

1
2

O 0Nk W N

UCF
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UCF

Context Menus in Editing

Each member of the Excel object model has properties, methods,
functions, and sometimes members of its own

The “.” operator following the object name activates its members list
Lists all that you may do with the object
There can be several levels of membership

|{Generan

|{GEHE[H“

Option Explicit

ExcElJ
i Active Ce
& ActiveChart
& ActivePrinter
i ActiveSheet
EE ActivetVindow
& ActiveVorkbook
! Addins w

Option Explicit

Excel., bctiveCell.
=3 Activate L
s A dd Comiment
& Addindent
EE Address
B AddressLocal
=B AdvancedFilter
B AllowEdit v

18



UCF
Context Menus in Editing

Many members require arguments and may have options
When adding a comment in a cell, type “(* after selecting AddComment:

{General)

Dption Explicit

Excel.AotiveCell. AddComment (|
AddComment] Fext]) As Comment |

Add the comment text, e.g. “This is my chosen cell”
Type “)" to end the statement

Options do not have to be between parentheses:
Selection.PasteSpecial Paste:=xIPasteValues, Operation:=xINone, SkipBlanks
:=False, Transpose:=True

19



UCF
Security Settings

Upon opening an Excel file with a macro the following warning
appears

To use the macro click “Enable Macros”

If “Disable Macros” clicked, Excel will not load the VBA modules

Security Warning E|

"C\Documents and SettingsMagdyDeskbopi My WorkiUAPS017 - FAIR
2003 WEA Workshop 03, xls" conkains macros,

Macros may conkain wiruses, Ik is usually safe to disable macraos, but if the
macros are legitimate, wou might lose some functionality:,

Disable Macros

L L A R Aas

[[ Enable Macros ]] [ More Info ]

If no warning appears, then security settings must be adjusted to

allow macros
20



-
Setting Security Level

= From the Tools menu, select Macro then Security

= Set the security level in the Security dialogue box to medium
= Restart the Excel file

kshop 03 xls

Format | Tools | Data 345  'Window Help  Adobe PDF .
Security
Protection L T Al Z f 100% - (G5 ! __
& | & = fe o4 &L (|10 - @ B | —
Solver.., .0 .00 | g= = | o ! :
| B 7 - % 1 Tﬂﬂ 20 | I= = | r . {h = & = ;b 3 Wery High, Only macros installed in trusted locations will be allowed
—— _ torun. All other signed and unsigned macros are disabled,
Macra Bl | Macros.., Alt+Fa
- ) High, only signed macros from trusted sources will be allowed to
C Daka Analysis. .. @ | Pecord Mew Macra... J run. Unsigned macros are aukomatically disabled,
=
Femal d ¥ . {*) Medium, You can choose whether or not ko run potentially unsafe
Fecuricy... TMackos,
2003 2004 2005
9 Wisual Basic Editar alt+F11 — ) Low (nok recormmended). ¥ou are not protecked From pokentially
1432 1432 1432 unsafe macros, Use this setting only if you hawe virus scanning
&% Microsoft Script Editor - &lt4+5hift+F11 OFF software installed, or you have checked the safety of &l documents
420 420 420 : = , you open.

Ok I[ Cancel ]
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UCF
Next Steps

We have introduced using VBA in MS Excel
How to record and run a macro
How to use VBE
How to debug and edit a recorded macro
How to set the security level to allow the saved macros

How to practice:
Record macros while perfoming different Excel tasks and study the code
Modify the code in VBE and watch the results using step by step execution

What do you need:
One or more Excel VBA programming books and the VBA help
Learn some general purpose VB statements
The IF — Then statement
The FOR — Next statement
Defining variables

22



UCF
Contact Information

Magdy Helal; Research Associate, mhelal@mail.ucf.edu
Sandra Archer; Director, archer@mail.ucf.edu

University Analysis and Planning Support
University of Central Florida

12424 Research Parkway, Suite 215
Orlando, FL, 32826-3207

Phone: 407-882-0285

http://uaps.ucf.edu

Presentation will be available at nttp://uaps.ucf.edu

VBA Resources:

MSDN: http://msdn2.microsoft.com/en-us/isv/bb190538.aspx
John Walkenbach, “Excel 2003 Power Programming with VBA”, Wiley Publishing Inc., 2003

23



=
VBA In Excel 2007

= The Visual Basic icon bar of 2003 is @ S

Recent Documents

replaced by the Developer tab in 2007

= |f the Developer tab is not shown on

among Excel menus, add the Developer

tab as follows:
1. Click the Office Button
2. Click Excel Options
3. Select Popular
4

Check Show Developer tab in the Ribbon

Excel Options @
-~ ~
' Popular = . . . M
I - l E‘@ Change the most popular options in Excel.
Formulas
Proofing Top options for working with Excel
Save Show Mini Toalbar on selection (i
- d Enable Live Preview L
Advance
) I Show Developer tab in the Ribbon (i I
Customize Always use ClearType
sdd-Ins Colar scheme: Elack vl 3
Trict Cantar | [0 | ¥
[ OK l [ Cancel ]

= =4

February 07, 2008

7 Publish

J“ Close
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SuUck

CCTransfer_With_AS.xls
FAIR - Sal study.xls =
FAIR - Sal study mh.xls

SUS Grouping and Pivoting 065ept2007 - 2pm ...
UCF_Continuing_Faculty.xls

Analysis.xlsx

UCF_Continuing_Admin.xls
adcomp_multi_report - Weighted distributions...
Table O3 far printing.xls

Table 01 -1.xls

Table 01.xls

FAIR - Sal study.xls

Copy of timesheet_yourname.xls
timesheet_Magdy Helal.xls

Data for 5 to F ratio first trial.dsx

M and F CC Transfer in Which Colleges.xlsx

I T V¥V¥TYTYTYYTIYTYTYTDWDWTYTYWTUW

testodsx

3] Excel Options [ X Exit Excel
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A S UCE
The VBA Ribbon in 2007

The Developer tab appears on the Excel ribbon

VBA icons and buttons look different from those in 2003
Buttons are pointed to

All buttons do the same functions as in 2003

b E =R Bookl - Microsoft Excel
Page Layout Formulas ata Review View Add-Ins Acrobat
facro 1 1, ‘ Properties e lmport

i e e sion Packs

=] Export
Source

Dacument
Panel

Insert Design
> Mode

H’.} Refresh Data

ﬂ Run Dialog
/|
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l.-

Security Settings in 2007

Trust Center

Click Macro Security in the Developer tab
Trust Center dialog box appears

Select Macro Settings

Make the settings as shown

?)X)

. A ~
Trusted Publishers — —
Macro Settings
Trusted Locations
Far macros in documents not in a trusted location:
Add-ins O Disable all macras without notification
L ctiveX Setti | @ Disable all macras with notification |
ActiveX Settings
() Disable all macros except digitally signed macros
" Macro Settings 'l | () Enable all macros (not recommended: potentially dangerous code can run)
Message Bar o | Developer Macro Settings
External Content i
Trust access to the VBA praject abject model W
oK l [ Cancel
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Security Settings in 2007

SuUck

= When you open an Excel file with a macro a security warning appears
below the ribbon with the Options... button

= Click Options... to show the Microsoft Office Security Options dialog box
= Click “Enable This Content” to all the macro

February 07, 2008

VBA Workshop 03.xls [Compatibility Mode] - Micros|

Page Layout Formulas Data Review View Developer Add-Ins Acrobat

General =

[|_avyvi|nr v\| SiiWrap Text

= || £E 15| EdMerge & Center ~ ||| § = % » ||%8 %8
@ Security Warning Some active content has been disabled, Optians... i
R15 - k|
4 Microsoft Office Security Options ? X L 1 d 1 K
1 ]l
2 = =
- @ Security Alert - Macros & ActiveX
3 |UCF
ON OFF
4 [FAMU Macros & ActiveX
5 FAU Macros and ane or mare ActiveX contrals have been disabled. This active content might
contain viruses or other security hazards. Do not enable this content unless you trust
G FIU the source of this file,
7 FsU Warning: It is not possible to determine that this content came from a
3 UF trustworthy source. You should leave this content disabled unless the
content provides critical functionality and you trust its source.
3 |UNF More information
10 UsF ’ \ ) W Workh \
File Path:  C:\...Magdy'Desktop\My Work\UAPS\D 17 - FAIR 2008'WBA Workshop 03.xls
11 |UWF
12 EGCU () _Helo protect me from ynknown content {recommended)
13 () Enable this content
14
15
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